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RPRELSE

32iaFERKRE

HHEERRE
1. EFEBEAPEFEBRERR&ED, TFANMED:
EFEREE
Schaeffler SmarfWeb

EREERE:
nEE -

2. MILFE5IFR Ak H AR AL I :

EWEIRE Wit kT E R SmartCheck 4. ProLink 154 :
o [FHEFLAETNZE,
o EAMNEHE. BEMNEHRELRLT,

B3h#% &1 Maintenance &t EE %% # Maintenance System, 75ix B A LUK S & EHYIESRThAE, H b

System BREEGEH. KSEEMRG A, ks, £ Maintenance System ikl EIEF 1%
FHHEEIET,

FAG SmartChedk: -> Maintenance System

Maintenance System

@ Update firmware % Reset data parition Reset firmware

— ! 5 Download debug log &
— m m
—— Adjustsystem setlings files ﬁl Open expert menu
1 Backup system t Restore system ® Reboot system
[ p S — Y ¥
Version: 1.0.20 (Build: 284980-20180815221038) Firmware 1.12.0 will start automatically in :58 minutes.

MBREEEHCE ), W E RS HI— D BRLXHEE, B R

t;:i BELIEIE I B A S8 R 19 & % Maintenance System,
BE Wi kT EE SRS X
RS E . FANENEHIEE &,
o EMFNECE, BIERME T I EREEBETRL,
EWRE ) BT kTS SmartCheck 4. Prolink & B RE FHITKRS:
R B BPRES . FANENEHIEE &,
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o MIBRATAERME T R ER L,

o FTEBEZE X,

o EHHETEHMHEIVRE,

A UERNEHE. BETHRERENERE, HE2: T8 AEIURESHER
SmartUtility %4 T HINESURFEE . KARHNRZE RN HBEEMNALEE Y, MERE
—REH T TE, EREXIRESZE, AT LUEL BT E L # IP it 1517 Schaeffler
SmartCheck &4, ProLink ¥ %, A BUERI X ME D, MARITEMIER.

3. BEHARE, AL § fiSmartCheck Z4, ProLink ¥4

TEHARAIT F B, FIERRATAIE .

3.3 FMNVF eIk #E VF wE4H

SmartWeb 4 3 L T BE 75 B Bt AN VP AT U1 5% VF RTIEZL o 45180 BT LA {55 R AN VF BTHIE 608 AR T F F S A4 BB 15585 06, 165
A L F SRS . 3 BLRTE VF RIIE S B AR A M A0 VF AT IE SR VP R E AL, R E R B R A B T H R ALE B AR

EIRFT IV el U B TR AR -
haina—s: 5 X
FrlESR BEEREE BmEILEE
Channel Monitoring 2020-09-01 2021-01-1
Email 2020-09-01 2021-01-1
OPC/UA 2020-09-01 2021-01-1
i #H

IRAITE AL R B R EETE & SmartCheck E4. Prolink ## LRIV RIIESIR LR LU TER:

YFAE &

"M

g%ﬁ{;ﬁ@lﬁﬁﬁﬁ% o BIMRTBL VLR B RRTIEE, ATERIVF A2 AR E A B A

JTIRERN T

o {SXEMEI : (5 AN BE S5 AEARIS E M I[N

o OPC/UA: JHEF0{EF OPC UA fR%-BBIEEE 2D

o B MR BN {E FE A RS Rl o)

o Schaeffler Cloud : /& F1{# A Schaeffler Cloud B{S:@E L& /i 5 Schaeffler
Cloud[ 6,

ZEHE R RV RNEM A RHATE R

MEHRRA 1.28 2B E FREE L. OPC/UA F1H, FHE4FIhAE,

X A% B A 5 h0 4 al ik 3k & i AT IE4H

1. ERBEADESITIF TR0, WETFRENMIED,
2. AdEMNR, HPGRMFEENERFE S AiEAE0,

3. FESURY RS R RHEE T L F R SR B8 TXT VFaliESXA4 T I



RPrRELSE

4. FXHEBIAE & FBIBTI5R,
5. TEH O BYSCAR R R i A0 VF AIE B VF AT UE 4 3F MBS ARSI XIS
AEXARETAHIN—FHER, NERGA RGN XEF R aEAHRER

IR AESE T A

Schaeffler SmartWeb

BETFEEREFITA BN, EMEAEFEHUETRE -

& Tl A TR ETT
<7xml version="1.0" encoding="UTF-8"7=
<syn:LicenseDefinition xminsoesi="http:favon w3 org/200 12XMLSchema-instance™ xmins:syn="http://fis-services.da/synergia™
xsi:noMamespaceSchemal ocation="LicenseManagement. xsd™-
<=gyn:Licenses=
=syn:License>
<syn:Propertiss=
=syn:ld=A515FF31-B993-451D-A000-000000 000005 </syn-ld=
<syn:Mame=Channel Monitoring</syn:Name=
=syn:Scope>
=syn:SerialMumbersF4:30:80:00:1C:99</syn-SerialNumber-
<isyn:Scope=
=syn:ValidUntil=2020-12-31T00:00:00Z </syn:ValidUnfil=
</syn:Properties=
<syn-Key=LBFVPJOKNXUCEhmCxn tedCsiQgtWep/uwRIDTR3GwDcQnd z o) dMMBuXxmSY GjglGdréRY WffdSFw\+i2 PR21drCpH2 kh 1HZemg Lzuzn
tDGmMV54nSg+gP+jAKvQgraMg0Qj2oMZlj6gUmzpw dglUkLJ2z AMIDIVP PrikmQLdAy3bdd X GoY 4K 2Cj0lj3qg KFhZWiggsmU UknUljX OxG+MZssATHpj
YovGEMsXaNidiGrZidkZ +Puw\WadpilPYIKDbHvxoBoQLAELThKssCRLWZJbri8J 2{2NdF 78 CzcOmS 0 GDbmiclsls abbkgr2aYkWaN Sh8Gvk DxCo3nx VT X
GZC==</syn:Key=
</syn:License=
<=syn:Licenses
=syn:Properties=
=syn:ld=A515FF31-B993-4510-A000-000000000007 </syn:ld=
<syn:Mame=Email</syn:Name:=
<syn:Scopes=
=syn:SerialNumber=F4:30:80:00:1C:99</syn-SerialNumber>
</syn:Scopes
=syn:ValidUntil=2020-12-31T00:00:00Z </syn:ValidUnfil-
<isyn:Properties=

<gynKey=0OMbt5CE 5z 5RadmVR03BaX0aYm1s/D5Fo/9t45Ke4F0gI0IFCnAMbulKWAONGK3ITq421 dkG5wRTH/8KpgabZRKPoe S GpY JgFzHsw2 +2
dNFVFLhjsqik3BKREmWC aTPkrT9i00tgFQOfyHWPwISsGEfEHKY QY +cNBRapdMx0SqWDju/wjTgZdDRyHnbDav3gSgUeny 29 7H+r1F GellkCOlww.)
Ow5xVoSRW\oRk2q3r3jNDe SXGIQFcA122iP3NIG pFvl3BbC 1 KICIF sNdGaysApelMUrot7 FXe3Liws 5SS EFGVOJZswlVmbxu 1 HAOTI GCuZ GIMVCD+

S5DuZEMoGSDA===/syn.Key=

SETE. —

RIT 0 AERAFTEEN 8 AES
6. milim, EVF AEEEERE O SE h RET RISV R IE S VAT iEd L,

XA BT A B ¥ R HIE
FEVFANEE BB HRIE ANV EIE, R MBROF B Rt BERIL,
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3.4 % Schaeffler ZiR%
INBREJF SmartCheck =} ProLink ##%# % Schaeffler ZARSS, NEE—MEEX 4. BEZHEXERFASIILLA,

#1315 Schaeffler =R KIEEMAAR
1. EEBBIEY % Schaeffler R Cloud-Onboarding £, LUETFFHEM B O

%% Schaeffler Cloud-Onboarding

— P EEritEESchaeflerCloud, FALIEERER FHIIEELES, FiEE, cloudschasfiiercom

O

I
B

s
+

2. AHRER UEHRMEFEREXE.
3. mAii OK ENa[/E3 Onboarding i1, A BUHR X ME DO, MAHITERER,

séi%tﬂﬂ%ﬁaiﬂﬁu;z Schaeffler Cloud B{EB&E[ B3 AT HITEIR L MFT BT A X E . BEN XSGR Proxy %
= | 138),


https://www.schaeffler.de/content.schaeffler.de/de/news_medien/mediathek/publikationen/downloadcenter-global-pages/downloadcenter-language-list-publications.jsp?pubid=87649857&ppubid=87649858&tab=mediathek-pub&subfilter=app:dc

% % B9 Maintenance System

4 %% B Maintenance System

Schaeffler SmartCheck Z4. ProLink ###J Maintenance System JN&IE2Ht & ERIRSEDIAS, BlIINERARSEFH L E 4, B
ESmartCheck E4. ProLinkix R Z 3 RAHREH LERG KT, MAMEARE— 1T EEE & $l1% %, Ltks+, Maintenance
System EHIZHR LML RINEE, LUEEH Maintenance System EiMIE& SmartCheck E4. ProLink %% LB RS,

Maintenance System (iR ZESThRA, M3 F iR A BB EH7FE, 15190 25 El 48 58 H 4 it a] LUE ) b5 28 7 B

$TF SmartCheck £4 ProLink #% % Maintenance System KA
1. EFEBEAPEFEBRERR&ED, TFANMED:

EREEEE
Schaeffler SmarfWeb

R

B EEGE -

2. iHMIEFEFIR fikRET B3 1% %/ Maintenance System,
3. ETHETE. B Maintenance System K& FE:

FAG SmartChed: - Login Page

Maintenance System

T

Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:57 minutes.

4. #ili Login W 41, 479 Maintenance System MI&E 71, A& Expert Menu o A L REw 2,
INERFE SmartCheck E4. Prolink BElFHBUET A/ B8, NMEEHIN—FEFNE, BOOIEREEABLERNE
Hil, ZRAFPEENERITHFE L
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FAG SmartChed: -» Maintenance System

Maintenance System

@ Update firmware % Reset data parition Reset firmware

— . ] 5 Download debug log il
—
Adjust system settings Lo fles k Open expert menu
‘ Backup syster | Restore systerr @ Reboot syster
— b sy — ¥ ¥
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:58 minutes.

5. Xk mdr— A EIbR, AR N R EE, IIREM E, BAPITRES BRE— P FER A HIEFFIEE. 5 Maintenance
System & INEEHR XHF4HE RIES W TFHIET,

. e 2% Maintenance System I, SmartCheck &4, ProLink ¥ # FR#rFrENIE !
lﬂ e #TFF Maintenance System RIETiTNEERT, AI7EA L5 EZ| Homepage (4 R, mIiR4H,
B XIREZE Maintenance System BB T,
e Maintenance System B2 — N EN 2R IIEE : MR KHFRELS), MEBNEREH. KERE
BURTF#RAL#E Maintenance System Ft 4 fii&
= Maintenance System BIZRT:2 HHEER
= Maintenance System BIE TFIFFBERITHEETL: 10 D4R ER
« LRFHAEZT Expert Menu:60 75
IMAERT A RREER R A RTRIT RIH [,

4.1 Update firmware: 5 #[&E &
m i Update firmware © B, FFRIZIEE, AL FERFESRAET RS LA TSR 2 51E.
MEHRATE, tha] ERZEFRARERE — N EIBMEHRA, EXFEAER T MR
ti 2 #IE
R AXBERERINT:
o 1.10.0 ZAT# SmartCheck KiAst# ProLink kA 1.18.0: AT LIRS Z E IBRIMRA
e 1.10.0 ZJ5# SmartCheck kRA=;% ProLink BEA 1.18.0: RAEMEZE 1.10.0 5% 1.18.0

BEHEGAR

1. fil Select file MW 243t 19REHHEE M SF2 X,
2. $TFF SF2 Xih. RO CHFSMET AT LIRS, MEA L, G L AEIFE 4 -

18



% % B9 Maintenance System

FAG SmartChed: -» Update Firmware -» Select File

()
Update Firmware
Firmware file: i smartcheck-at91-FAG-1.12.2 20170502_164020-395886 512
I The selected file contains the firmware 1.12.2 (Build: 20170502_164020-395886). I
AT A TO U0 TE e O Calter 10 a00TT.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:45 minutes.

BT A A AR E R, b2 B4R 2 EA.
3. md ok Y il FIRES.

o EEHEMHN & LNAANERIEASEX, BELREEL, RLERFILEL
ti SmartUtility 24 THRNEHIBENEE, MF—U&0 . REFHHZR(EEEENARES, B

EERE—EHETHTE,

o FEHEIREIFSL O H, FEIXERIS A A SmartCheck ZE 4, ProLink %4 £ LED KT BN
MREAMIE, EHAUT/LAREE:
o FB#rFF SmartCheck E4. ProLink % &8 HLE#4,
o FBHIFF SmartCheck ZE4. ProLink ¥ &I LI K MIZERE,
o WSERTEREH.

INBIXLAHREHREHE, BERAEERIEER!

o MNRFEBEMGFHARIEIT —NEMHIR, WEAHEE LER T BERES, X R RE SR
ARA[SHEE > IRAER,

o MMBRBEMITEMEL, EELEN N Cache, AT HEAIN WIS FZETIRAR Schaeffler
SmartWeb ##, XRELE,

4.2 Reset data partition: EE#HFEH K

mili Reset data partition % i, FRIZIIYRE, AT EERES X NS BBRRSFH N EHE, NEE
ERFRA,

s ok v iz BEMIEAK.

4.3 Reset firmware: £ Si@E#

mii Reset firmware =) %4, FzhtHishae, AILAEX BRI HIES X, L3I ER 2 S a9Fr ATl E R &M E 2
7, FERERNNERE.

s ok Y imi, g HEE.
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4.4 Adjust system settings: HE RS XE
#ili Adjust system settings 3= 141, 1T EARS LEMAENR L

FAG SmartChed: -» Adjust System Settings

Adjust System Settings

ﬂ] Edit system name Inp:.:4 Configure IPv4 settings
@ Configure NTP server ::P‘Té-& Configure IPvG settings
@ Change administrator password E Replace server cerificate (PEM)

Wession: 1.0.20 (Build: 294980-20180815221038)

RiTER—MEHL, ITHFENKHYIRE, SEUWRAXNERIES L TIET,

4.4.1 Edit system name: & 5 R 4 &

>

mili Edit system name @D iz, FF B ZiThee, "TLATELL Y SmartCheck ZE4. Prolink ¥ % % & — 1N &4 7.

HERGATRNAR
1. TEHMAED NS SmartCheck 4. ProLink 4 A R F5:



% % B9 Maintenance System

FAG SmartChed: -» Adjust System Settings - Edit System Mame

>»

Edit System Name

System name: FAG SmartCheck 36

Enter system name and click OK to save or Cancel to abort.

Version: 1.0.20 (Build: 294580-20180515221028)

2. s ok Y Al BB

4.4.2 Configure NTP server: B2 & NTP fR % 38

sl Configure NTP server (O %41, 35 %0 thae, TLZEILHE— 4 NTP AR5, SmartCheck B4 Prolink 4]
BUAK 2B 2% 58 1K ER TR GG i

BCiE NTP R 553805 %
1. fEfAMESRIA NTP 552589 IP itk sk NTP AR %5382

21



22

FAG SmartChed: -» Adjust System Settings -> Configure NTF Server

>»

Configure NTP Server

NTP server: ntp.rhrk.uni-kl.de

Here you can configure an NTP server from which the system can load the
system time.

Enter the NTP server address and click OK to proceed or Cancel to abort.

v X

Version: 1.0.20 (Build: 294580-20180515221028)

2. it oK Y IRHL BA TP ShhESE NTP AR B4 H.

o IREMR NTP RS8BT, WA A DNS iR %525 80@1 DHCP WEE.,

ti o NIRRT NTP RSB[R ERSGN 1, METMHITRSL . Eitk, SmartCheck &4 ProLink %
WDANRZOERETIM S, FELAURA R AV H NTP 5548, FRIRAZAE,

4.4.3 Change administrator password: £ & & & & # 1%
mii Change administrator password E=g B, FRIZIDEE, EX B UERA EENEE BT,

EREEAFBLEHAR
1. 7 Administrator password iE i AFTEZH,
2. 7 Reenter password 1EHE R AR :



% % B9 Maintenance System

FAG SmartChed: -» Adjust System Settings -> Change Administrator Password

>»

Change Administrator Password

1. ————» Administrator password: sses
2, =P Reenter password: sene

Here you can change the administrator password.
Nete: Leaving the password empty will disable the user management.

Click OK to proceed or Cancel to abort.

Version: 1.0.20 (Build: 294580-20180515221028)

3. sk ok ¥ il gD,

) IR LA — DB AE, WK SmartCheck E4 Prolink &4 £ B2hBGER - &=,
t;. MBRERBHA—DEEAFN, WKTE SmartCheck B4 ProLink ¥ # 2R EH,

4.4.4 Configure IPv4 settings: B & IPv4 % &
s Configure IPv4 settings W, TR, ARG IPvA WA UHE,

YniE IPv4 WK R BRA
1. M DHCP mode %|& it s DHCP &= :

23
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FAG SmartChed: -» Adjust System Settings -» Configure |IPv4 Settings

()
Configure IPv4 Settings
DHCP mode: DHCP: Send host name to serve «
Host name: FAGSmartCheck
IP address: 10.179.7.241
Netmask: 255.255.255.0
Gateway: 10.179.7.254
Name server:
Select the DHCP mode and configure the network settings for IPv4.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038)
&F LU ILD:
No DHCP FIFZE DR LU SE IPv4 Hhiik, sRE k2L SmartCheck E 4. ProLink ¥ 7% ROk

i\ IP bk,
INEEHHE No DHCP, 4 thh i %S EPHATHEWIE, 5110 IP address,
Netmask 3 Gateway,

DHCP: Send host name to  FIAi%i%5 SmartCheck &4, ProLink %% 8] B RO b ER IP Hutik, F 4

server L8 SmartCheck ZE4, ProLink ¥4 7EMZ /) DNS AR4- 28 &1,
DHCP: Load host name from F|fBi%i% SmartCheck E4. ProLink %% 8] B RO bk ER IP Hutik, Bl
server M58 DNS fR%-F/ A EEEHN B .

2. ¥ DHCP mode i%&#ME, #7i#f Host name. IP address. Netmask. Gateway = Name server T EEE
iR,

3. st ok ¥ iHl, BIEREERERALER Y.

o INETH SmartCheck E4, ProLink ¥ ##0 IP Hhiik, N7 Z @TAtt FARBIE 7 W SmartWeb
g Wk, SRR TE N EBS hii A BRI s thkik, EHTE A B 4EF0 Maintenance System,
o HNEFiL DHCP BaI4ER IP #hilk, NN A& B304 BECh IP ik 8@ 4B FR (DNS) Vi il
SmartCheck &4, ProLink %%, 2 BT EFE AR IP Hhil,

4.4.5 Configure IPv6 settings: 2 & IPv6 #% &
sl Configure IPV6 settings s Hill, FFIE 1% haE, AL LA TPV6 W% B &,

HiE IPv6 M KB A R
1. M DHCP mode %X FikH s DHCP &= :



% % B9 Maintenance System

FAG SmartChed: -» Adjust System Settings -» Configure |IPvE Settings

(2)
Configure IPv6 Settings

DHCP mode: DHCP: Load host name from sert|

IP address: fes0::fo3d:80ff:fe00:1336

Netmask: 64

Gateway: 10.179.20.254

Name server:

Select the DHCP mode and configure the network settings for IPvG.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:57 minutes.

&F LU ILD:
No DHCP FIFZE DR LU SE IPv6 bk, S& k2L SmartCheck E 4. ProLink ¥ 7% ROk

A IP ik,

R %A HE No DHCP, B34 thh S iZE Wb ITEEWE, 510 IP address,
Netmask 3 Gateway,

DHCP: Load host name from F|fBi%i% SmartCheck 4. ProLink %% 8] B RO 4% b3k ER IP i, Bl
server M58 DNS fR%-F/ A EEEHN B .

2. ¥1 DHCP mode #%:#iME, % 4i7EIP address, Netmask, Gateway i Name serverli F#5E HE #iE,
3. mid ok ¥ i, iEIGHERERA RER .

o IMEFEX SmartCheck 4. ProLink ¥ &80 IP thit, N7 Z BTt FARBIE 7 W SmartWeb
li WA SRR NTE N L BR th i A BT e % ke, EHrE AR
o NEREiS DHCP B34 B IP thilt, N al@ i B3R ECAY IP Hhibsk@it EHM B 5 (DNS) i il
SmartCheck 4. ProLink %%, 2 GR¥FEEFEARA IP i,

4.4.6 Replace server certificate (PEM): & #: R £ 28 iF

mii Replace server certificate (PEM) G B, FRiZUhEe, REB[BIFPATHIFE MRS 25, AT LA @ — 4
B O BIAR S 281EHE ¥ SmartCheck 4, ProLink &% LR7E T HIARSS2RIE T,

HE#: SmartCheck E4 ProLink % & BRESB/IEBHAR

1. i Server certificate file MW i%:473t18 % AR EIR %S 21 18 PEM 3XH,
2. #TFF PEM XH-FHENERN 7£ Passphrase {Edfii A PEM X#HHE X

25
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FAG SmartChed: -» Adjust System Settings -» Replace Server Certificate -= Seled File

>»

Replace Server Certificate

Server certificate file: i server2 pem
Passphrase: sene

Click OK to upload the server certificate or Cancel to abort.

v X

Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:52 minutes.

3. mii OK v A, BRI RGE5 AT S S FE T LR B ST A H@ A0 -

FAG SmartChedk - Adjust System Settings -» Replace Server Certificate - Install

>»

Replace Server Certificate

cert. versiom : 1
=erial number : B8:C5:€3:FA:28:A3:52:8€

i=z=uer name : C=DE, 3T=EY¥, L=3chweinfurt, O=3chaeffler Technclogie= GmkH & Co. EG, OU=—;

m

CH=www. fag—=smartcheck.com, emailiddress=industrial-services@schaeffler.com
=ubject name : C=DE, 3T=BEY, L=3chweinfurt, O=3chaeffler Technologies GmbH & Co. EG, OU=—,
CH=www.fag—=martcheck.com, emailiddress=industrial-services@schaeffler.com
ismsued on : 201E6-07-14 08:27:02

- SnA%E-AT-1= AB-29-07 i

The server certificate is ready to be installed.

Click OK to install or Cancel to abort.

v X

“ersion: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 2:48 minutes.

RSP R A A RARR S BT, IR A B AN,
4. =ik ok Y imEl, mERSBIED.



% % B9 Maintenance System

4.5 Download debug log files: T ## & H &34

mii Download debug log files @ R, FFRZIThEE, AIEL OB F T HBEREX G, ERATEELEFIZX
., IR E REE BRI ARIRS i, AT T AT,

FTHRESIHGHR
1. ik ok Y e, FamimURE.

2. SIS BB RS A AR X RIS,
3. WGBRGHREETH . BT, RS AIEER A TR H bR E *. SCLG B HEX .

4.6 Open expert menu: T ERFEH

il Open expert menu &6 %, FERS LRE 1S LIER,
L RFE A A EIREt 4 Schaeffler SmartCheck E4. ProLink % & E KRG BEHIIRE, B VXERBNRAMERXE
, N A E LA — A BN R A R LR, SR BT R AL MBS ERIES L THE T,

ERRAREERBFHIEAR
1. AEXEFHUE L LE— ID, ATLGEL AR, th el LB 141 ID HA S BATRIEAZ R D,

FAG SmartChed: -» Open Expert Menu -= Login

>»

Open Expert Menu - Access Verification

This section is password protected. Please call the customer support to generate
a one-time password from this ID:

— fadbbcB7

Click the button below to log into the restricted area. Enter the user and the
generated password for authentication. The password is valid until next system
reboot.

1

Version: 1.0.20 (Build: 294580-20180515221028)

2. BAIMBEAZFROENZ ID £R—1N—RENFLFE AR,
3. Aii Login 1) R, FTFIIETL, £ User Name EFHI A&, F#7E Password 1EF i A— R :

Authentication Required @
9 A username and password are being requested by http://192.168.178.50.
The site says: "Web Server Authentication”
User Name:
Password:

[ oK l| Cancel |

27
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4. st ok Y fREL I RE T

FAG SmartChed: -» Open Expert Menu

>»

Open Expert Menu

@ Reset administrator password D Start remote access senvice
—
} Replace cryptographic keys % Update Maintenance System

Clear entire system @ Reboot system

=0

‘ersion: 1.0.20 (Build: 394580-20180815221038)

RTER—NMEHL, ITHANHDIRE, S ERELSNMREXMERFES LTIEY,

o Y HAF Maintenance System Hlf, ID F1—REFHIGF B, —BEE SmartCheck B4,
li ProLink ##%, ID F1Z AN %, EE Maintenance System I, £H—## ID, AFALUE
EEMBEAR Z iR — N D

o HEREFMEHIAF 60 NI, B% AT B RAIRS HDKIR—REEN, R L

5@ $RHLEA Maintenance System 3 MIRILERHEEE FIEFEE T, IR BER
SE 60 i,

4.6.1 Reset administrator password: £ & & i % 1Y

&l Reset administrator password =8 4, FBi%IiThaE, 70X B AT LUSEHE A B0 £ 1 5 356 M08 4R A
BURAPATUSERAZENELFHEEEINR, AZERA N EE,

s ok Y imi g EE R,

&/ Change administrator password| 2 1&g, EHREE 51 %15, 5&iT Maintenance
li System EFE i) Adjust system settings £ FI48 X e,

4.6.2 Replace cryptographic keys: & # il & & 9

s Replace cryptographic keys & B4, FFEZIThEE. NEERLA TR R E 83X (*.SF2) #1442 X (*.SCBK)
LAR N &3 SR B 530 SR EM K BT, WA JE#H, HEBRRFIRERS ERETELR .

B mEmE R R A
1. i Keystore W 2413t 8% B A MBS LAY,



% % B9 Maintenance System

2. ITIHFXHE:

FAG SmartChed: - Open Expert Menu -> Replace Cryptographic Keys - Select File

()
Replace Cryptographic Keys
Keystore: [@F smc-bkbin
Click OK to upload the cryptographic keys or Cancel to abort.
v X
Versicn: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 9:52 minutes.
3. Rl ok A, EALINERERL . RYUS AT S FFFE T LA T S ST I i @ A0 -
FAG SmartChed: -» Open Expert Menu -= Replace Cryptographic Keys == Install
-
(3]
Replace Cryptographic Keys
The cryptographic keys are ready to be installed.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:45 minutes.

B RAEERMERL, b2 B8 2B,
4. =ik ok Yimh mEsonESRL,
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4.6.3 Clear entire system: 5 £ M B& & 4

mili Clear entire system ] B, FRZIThEE, IR EEE 4. BB I = $HEEARE A RS, Maintenance
System BIEEIRERZ 820,

1. m=ilf OK v il MEREN RS RABMIRR, ERFTIRT:

FAG SmartChedc -» Open Expert Menu -= Clear Entire Sytem

>

Clear Entire System

The system has been cleared successfully. You need to install a
new firmware.

Mote: Please configure the IP address, otherwise the system will

be reset to the default IP address "192.168.1.100" afier reboot.

Version: 1.0.20 (Build: 294580-20180815221038)

2. NELNRE—NHEE, 1ot BRI EHEE SmartCheck E4. Prolink 4 IP #ilt, EoAEBEBT HITHRIEE
SIZEERA IP Hedik,

{fAT Clear entire system 12/£75 2 f5, SmartCheck 4. ProLink ##% £ S EBFFEEIE &,
li EERRFERZLA, AIRATIAR:

o i&iT Update firmware[ 1" 3 &7 80 E 4 ST 0k = ¥4 £

o @il Restore system[ s\ {5 — 1 Z AT M AR XHEEENREMBE RS L,

IR E B RIIESGE T MEANThAE, U4 20 B R AN e B HE (a7,

4.6.4 Start remote access service: i@ i RAS E 1% 18 ij 1

/il Start remote access service - B, FRIZUIhEE, BAIMBARZFRILALED FTP/Telnet AR5 271EB11ZTh
BEN#RIR{E Maintenance System A HERIEEEN, EE SmartCheck 4. Prolink % 2[5, 15453 Remote Access Service
(RAS, zF2 V5 MRS o

it RAS FEIZE I AR
1. =ik ok ¥ 240, Eid RAS FFELAR ) i
2. RAS MBS, R4 K HAANIER



% % B9 Maintenance System

FAG SmartChed: -» Open Expert Menu-> Start Remote Access Senvice

>»

Start Remote Access Service

Here you can start the remote access service (RAS). This function will enable
the support team to assist you via FTP/Telnet.
Click OK to proceed or Cancel to abort.

Version: 1.0.20 (Build: 294580-20180515221028)

4.6.5 Update Maintenance System: & # Maintenance System
mii Update Maintenance System % B, FRiZUihRE, AITELL Ef£—1 SM1 304, E#F Maintenance System,

E# Maintenance System 5 =X

1. =i Maintenance system file (i B H B REBFFTE Maintenance System B SM1 X4,
2. T3 SM1 Xt RE DX EFHEEHER Maintenance System BIRRA :

FAG SmartChed: -» Update Maintenance System - Select File

()
Update Maintenance System
Maintenance System file:  [gi smc_rescue FAG 1.0.22 smA
The selected file contains the Maintenance System 1.0.22 (Build: 20170502_164020-395886).
Click OK to upload the file or Cancel to abort.
v X
“ersion: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 2:50 minutes.
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WNEFE TR EH Maintenance System, Nt &3R5 X @50,
3. A# 0K v %4, # Maintenance System,

PATZDIRER FA R BB PR H A L FHMFIEHEE SmartCheck E4. Prolink # %, SRR HTITIEH
ti HELE R, A0 B8 AR EHA T RARZFF R D,

4.7 Backup system: %3 % 4
mili Backup system G R, FRIZINEE, ATUERGE— N RALX B XY, EHEEFERHE. BEEMKE, A&

Restore system[ s DIEEL 3 B — DR RIE E RS, HE & H1%%, LUEFHIMEE LEZE %4 SmartCheck
E4, ProLink %4

#RFREHAR
1. MIEFFIR PSRRI SRR

FAG SmartChedc -» Badup System

»

Backup System

You can create a backup copy of your system, for archiving purposes or for
safeguarding firmware, configurations and data.

Select a backup type and click OK to start the backup or Cancel to abort.

Firmwrare with configurations and data hd

Version: 1.0.20 (Build: 394580-20180515221038)

R/ AT

Firmware with B ZET AR EHIRARE, NERBEHFZD
configurations
(without data)

Firmware with Bz ISR EE . RAREMNEHIE.
configurations and data

2. mili OK v A, BINRTIE &R B FF TR 12 TUR 4R
3. [{TEREMXME EEFEMERXRELE,
4. WUIERRGERRE XM BT, R RIFEEOA T HOCHJerp ik E] *.SCBK %473 XX 4o



% % B9 Maintenance System

MEEEME, A FArmware with configurations and data JERISXEATREIEE K, T
FEMRNEAKBIN ], 7 TFEER, ENBR/UBEIRAMR BN 10 75480, TREIH,

i

4.8 Restore system: £ § &%

il Restore system i, FR TR, B AT 2 ATOIRI A XA B LR, SRXBNEE
BEHMEESESAEN RS, BB, BEMME . G100 UG — %40 XHMEE— 15189 SmartCheck &4, ProLink
Bk, BIZATB &, o, EAIUERSMXHRBRERAEFHES UG L,

BRIEERGMAX

1. Al Select file MW 14318 EHFHER %M SCBK 34,
2. $TFF SCBK 3Ci . RUTHT ST 325 4N 1o 31 & R LE [ 4

FAG SmartChed: -+ Restore Systemn -= Select File

()
Restore System
Backup file: i f4_3d_80_00_0d_ce Backup.scbk
The selected file contains the firmware 1.9.17 (Build: 392442-20160212111841).
Click OK to restore the system or Cancel to abort.
v X
Versicn: 1.0.20 (Build: 384580-20160815221038) Firmware 1.12.0 will start automatically in 2:45 minutes.

MRATEXHEFEFARMEA X, NBRRGHEXEN,
3. mii OK v il ARSWERIEERRHEHEE, LUEE SRS
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FAG SmartChecdk - Restore System - Restore Configuration

(2)
Restore System
Do you want to restore the backup to a replacement unit or an additional unit?
@ Replacement unit ) Additional unit
The selected file contains the firmware, the configurations and also measurement data.
Do you want to restore the measurement data too?
Restore measurement data too
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 2:41 minutes.
BT L
Replacement unit NEREFRASTMXBE—E SRARSLBETZRS, WIEBE ZIEI INRATIE &G
X th &/ N EHE Nth=HI Restore measurement data too 7 (. T3l
YA o
Additional unit INBEREFRAAD G RESFERE £ FIZEHE SmartCheck E4. ProLink %4 L, I
T EUE L I
Restore measurement NETHER T F BRE 1ZiEI:
data too o FAKRXHERTEEEHNREZN, CEHNERE B

e #ET Replacement unit i£7if5,
BRI, LME— RS & % XHMNE8IE. BNER T ZsD FERARKS, B&
RGN F RN ERE.

4. =ili OK v R, MINERIEREFTFIRE & RS,

o WMREZ 25 Restore System Thierh i, & EEHBEALTF SmartCheck E4 ProLink
li #% k., B3h SmartCheck 4, ProLink ¥ % f&, Maintenance System T, R WIS E 4
HEEE % L, Hln&Eid Update firmware 5 Restore system IhAE,

o QIEEMXHN, FREFHAEMNART, TUA—THOXGF A HAIMM L L, R BT
Restore system &3 X LA E— D Eics L, WHTKH RIS i REFERZ,

4.9 Reboot system: EE & 4;

mii Reboot system @ R, FFRIXLIThEE, ATLUEBILEThEE X R4, AR ER., B4 5E B3I EEEIRIT R A,
Maintenance System BIFE I 23 ThRE[ 18 VR TE %I 7],

s ok ¥ i B ERS.

A LAFE Maintenance System BUE 1 F1L RE A hR B % IEE,
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I L I BRI E B S (L A R R A MR (B BT FERFRABERRGER ), F
AR ER S/ B HEFUATER R G 25,

o BIEWRDS HMIZHIIN Schaeffler SmartCheck E4. ProLink %4 %I R4 2 A H B (St E
ZERHEAEHRS H,

18
0

1

9 BRI R ST R H o

1.

2
3.
4

8725 REHRAEAIRG P

TEUTE Pl B X F e 5 EEH RS /EBEEEE S E| Schaeffler SmartCheck &4, ProLink ¥ & 2 5 LL
REZGRLE S IR RETE R AR EI R4 FN Schaeffler SmartCheck E4. ProLink ¥4 Z [T @ISR LA REI, BATE TSI

il

o =EK#H — GX Works2[113)

TEART AR BB IR H RS LIE S Schaeffler SmartCheck E4. ProLinki% £t {T#1{E, LLRTE Schaeffler
SmartWeb 4 hEEZMLEAA X EEMIFAER, XBEZMELS BT

M“?‘!"‘:"P!"!“

iﬁ*ﬂiiﬁﬁ&
TH&ES
EHIRSH IP ik

HEENREPHEBEERE

7£ SmartWeb K4 hHmEFH RS

7 SmartWeb 4 5 N H1 % 4 % A tis

7 SmartWeb 4 = #0261 3% 4t % H i

Fa a5 iR E E X RFE SmartWeb X

HEEXHIEA GX Works2

. CREFRFERERHRS
X 25 TR PN BB 1 i 3R O5e | 114— 5 FR B ER A R B

EEHIRS:

## 0 (Host Station Port No.)

A % 0 X

HEME L
communication_ok: TiE

error_configuration_inconsistent: |tk Schaeffler SmartCheck E4.
ProLink %% EEI4FIEELAMERE, AETEFBIEBEAZGRS S, BEH
RE AN, HEHM Schaeffler SmartCheck E4 ProLink %% THECE XHEH+
WAEEH RS 1A,

error_reading_values:Schaeffler SmartCheck 4, ProlLink 475k M|
REGhiEH— I RES U, RELEEH IR BSERES N BEEN

error_alarm_state_not_updated: Schaeffler SmartCheck Z4. ProLink %
REZF-IHESMABTAIEH RS 2h, BELERHES N BEl6),

AN RIF 58— Ve 3R ik o AR g 4 Lt I RO R S
. EEEEENR L RHNREMEHIT AGHE 7 TFES.
fEBIE ST R ER, A RTTERBEIL.

. AT RIEIAFLEE, S EREERE SRS ENERHRS. A FRFHARAB SRS R whE bk
XA

172.28.205.122
+33t : 1280 s+ /<t : 0500
TCP(MC #ri%)



[

141X (Communication Data  —j#&l
Code)

s R AL x

BRI T A RS RS0 Schaeffler SmartCheck E4. ProLink 154 2 1] g 12 -
o ITAETEEFIRSMNEESS D1000 MHEIER , XN EFEHJMAZLE N WORD, aTTH({ESER v 0-10000, ENF
Wt 5 2155t 0-3000 RPM,

o b4}, #ZSchaeffler SmartCheck 24 ProLink i #IENFE AR BB ZAREF ISO FEEMRERSURKETA
ZEEFIRGHNFFRT LEARFNAEFFR D1200 FFF A,

8.7.2.5.1 =& ¥ GX Works2

SR 1. ABRRNRGHHEERE
B KES Schaeffler SmartCheck E4. ProLink % % {TEIEFFBMNFAES
1. #TF GX Works2##,
2. Hil; Project > Open,
3. HAFEHRAEFARAENDER,
4. ESHMBEODNT Parameter > PLC Parameter,
) Parameter Setting

PLC Mame |PLC System |PLC File |PLCRAS |Boct File |Program |SFC | Device |1 assignment |Mulkiple CPU Setting  Builk-in Ethermet Port Setting |

~ IP Address Setti
TS SIS I Open Settingl
Input Format IDEC 'I
FTF Settirng |
P tiddrese [ 172]  z8] sl |
Tirme Settifg |

Subnet Mask Pattem | [ | [ |

Default Router IP Address | [ | [ |

Setifitiz needed] Default / Changed |

5. TEZIIR Built-in Ethernet Port Setting §1 .37 Open Setting,

IP Address/Port Mo, Input Format  |DEC -
Pratocal Open System TCF Connection H?:,S;[? ﬁg?n ?;ﬂ?;gz: D;ztrlmt;.:n

1 |UDP ¥ |MELSOFT Connection

2 |TCP ¥ |MELSOFT Connection w hd

3 |TCP * |MELSOFT Connection

4 |TCP » |MELSOFT Connection = hd

5 |TCP » |MELSOFT Connection = hd

E |TCP * |MELSOFT Connection = -

7 |TCP ¥ |MELSOFT Connection = -

8 |TCP ¥ |MELSOFT Connection = -

q |[TCP * [MELSOFT Connection = hd

1o |TCP ¥ |MELSOFT Connection  w A

11 |TCP ¥ |MELSOFT Connection  w hd

12 |TCP ¥ |MELSOFT Connection w hd

13 |TCF ¥ |MELSOFT Connection = hd

14 |TCF » |MELSOFT Connection = hd

15 |TCF > IMELSOFT Connection_» >

| 18 [TCP + |MC Protocol - - 1280 |

{*) IP Address and Port Mo, will be displayed by the selected format.

Please enter the walue according to the selected number,

End Cancel |
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6. HATTIIRE:

Protocol TCP
Open System MC Protocol
Host Station Port +it#: 1280 (48 F+7XitH:0500)
No.
7. mii End HiLNKE,
Q Parameter Setting E2
PLC Marme |PLC Systemn |PLCFile |PLC RAS |Boct File |Program |SFC |Device |TO Assignment |Multiple CPU Setting Built-in Ethernet Port Setting |
IP Address Setti
ks SIEHITE Open Setting |
Input Farmat IDEC ’l
FTP Setting |
IP Address [ 172] =8| zosfizz
Time Setting |
Subnet Mask Pattern | | | | |
Default Router P Address | | | | | seriici needed Default / Changed )
r— Communication Data Code
* Binay Code
© ASCI Code
[¥ Enable online change (FTP, MC Protocol)
[ Dizable direct connection to MELSOFT
[~ Do not respond to search for CPU [Built-in Ethemet port] on netwark:
Print Wwindamw, . | Print WWindaw Preview | Acknowledge XY Assignment | Default | Check | End Cancel |

8. 7£ Communication Data Code i T X & LHitE = Binary Code,

9. & Enable online change (FTP, MC Protocol), M a4 Schaeffler SmartCheck 4. ProLink i85 A1 %
gimn,

10. ¥ End,

11. ¥REFESE Task #,
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[

E.r'_.: MELSOFT Series GX Works2 E:\_a\lm\_"m\!FAG_SLMP_Test\neuw.gxw - [Task Setting Task_01 ] i [ m] 4|
! Project Edit Find/Replace  Compile  View Onlne Debug Disgnostics  Tool  Window  Help -9 X
NEAg e fixpRey REFSsRAs s ne A8 0 mw B
ErEIEE R e Y O EERET
i Navigation 7 x 5| POU [PRG] Program [Slj/ g Task Setting Task 01 | % ] 4 b -
C G B
1 _[POU
CF o B 2 B 1
[#- Parameter K] ]
Inteligent Function Module 4
- 4¥ Global Device Comment 5
EI@ Global Label B
Bl Globall 7
£ Global_Vars g
=R @ Frogram Setting 9
----- ﬂﬂ Initial Program 10
L—_I {j’ﬂ Scan Program 11
= MAIN 12
- Task_01 1
- {gd) PoU 14
ﬂﬂ Standby Program 15
-{ |} Fixed Scan Program 16
ﬂﬂ Mo Execution Type 17
Elm{:.:?‘ POU 18
E@ Program 15
=-{gd) POU 20
o Program 7
‘i Local Label 2
g FB/FUN 73
I'_'I E Structured Data Types 24
@R SmartCheck_172_28_205 46 T 25
----- @‘j Local Device Comment %
[+ Device Memory 27
Device Initial Value 28
29
m -
&L =S | ]
Enaglish Structured QO3UD Ul

12, @i R A ik Compile > Rebuild AILUE FiERF
13. FREFEHMEER RS,

1£ Schaeffler SmartWeb 4k 4B B HIR S,

$I1% 2: % Schaeffler SmartWeb %4 5N $l R 4
EEEEEN TR RINTFRS, ZASFH5SEITISE

o BEF—THRPIEFENEUBRBEBEMEH RS,
o EEZANHRPREMIEFIRAMLUTIER:

SER GBS EE
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HinEEEE

Schaeffler SmartWeb

TR F3: BC® Mitsubishi Controller (SLMP)

1 SRAEAEAY

2: ELH Mitsubishi Controller &} :| PLC_O12

[SLMP)
1P #ibk | 17228 205122
WmO:| 1280
=R ]
Wi | Top -
R 2 | Binary -
g
EEIE
= EC# Mitsubishi Controller &7 -
b= EE A FEEEFHEOLE
i2iE,
THEE EE SER
2% PLC_018
IP Hhiik 172.28.205.122
prfm] +it%:1280 (48 F+ 7}l 0500)
1738 TCP
iR =R it

YRATTE SO0 ) SR B R TR i oD 1 ch 4 B % F Al R iR RS MEZE A,

BEERARIEVES, TR dEEN R mRZIMRERSEH, NEIEHBHER,

Cl

S IE 3: 7 SmartWeb X {4o1 iF N2 & R St 8% A i
T EEEEMNHAN:PLC_018 Wi T Ad M #A & FMHA BEOhIHTUTRE:
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LA

Schaeffler SmartWeb

£/ | FSPLC_0M18E9EE

TR | D1000 (7]
FEEER: | WORD - @
BEE: | S=sa v Bir: rPMm v @
ERAHE: | 13 - @
E5H: RPM
B [RPM] : 200=2
163,837 .
By
16.38 100E3
B [RPM] 2 .
0.0 SLEs
2E3 4E3 6E3 EE3 10EZ
BT BAAE
o 0.0 10,000
2% #5% PLC_018
MIREFR D1000
FHEHExE WORD
iR 7% :c4 AR [ 3R
L::R (72 RPM
FHEE 1% Max s fEiEgy 10000,
ESE B3 Min S AE 0 F4H0 Max Hi A # {5 3000,

1RE]1E RN [ 4% 58 120 1 T 45 B A A\ B (1082 1 R B % Fanfal R iR S RS AR E 2 A,
o HERE7E Schaeffler SmartWeb #4465 T4 Ak, a7 S i B R [\ il 275 B

!J Schaeffler SmartCheck E4%. ProLink &4 k1R,
o Itk At =T FO P ER G A b — FETE D 2 4E 55 it TEA.

T 4: 7 SmartWeb {4 th 6l 2 #2 %R 5t 89 % H B
7 GBS EE R M H I PLC_018 Wi T mdi G 3# B HRSHE - NS RPETUTRE:
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AR

Schaeffler SmartWeb

&R S TR IS ER

1: REFTEMEFRE

P ’Wgﬁif* : RETE o
E?:I;;*: . e
FHEEER e
WA EE RERS H RERE
o BERE A
i — 4 GEREES v
— & Base measurement job v
Q2T LEEE T
@ FrandyFor (A8 -TE-LBETT
v
@ 120108161 (2Hz - IkHz,‘u-;EiE . v
Q@ o7 b —E—F I (BEE. ) v v "
SHFiGE ki Exy
RTFFR D1200
EHE TR S KA R SR B R R AR,
AT AR E Bt B AR BAE S5 15 (R BN E RS S50 ISO 10816-1 FHEHIE PR ERAE

BUE 0TI R AR A R BY/ME

ERSHE SR AELEMNMER B RN FRE . EEERMN/ 558 R 5 R 5% 3 NS b B X F anfa
QIR EFEF RS M IRMEENEZER.

H 18 5. G B AR R 5 H i B E X4 77 SmartWeb % th
1. 7 BEEEER St S B L 2 R 4 (B0 PLC_018).

2. md ¥ TREATTHREAEHRS M SR E Y,
3. STHEEXH:
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Schaeffler SmartWeb

Iitw EF v JEGE VY FA VW
2§ BiEEE
£} PLC_018
172.28.205.122
wmOo . 1280 R
Bl TCP
SR, Binary
= - R
ope OPC UA server s wR -
oh PLC_018
BEFA—u BiEEEMSA : PLC_018
+ [ &%
@ #=% B WHATE iR BRAR
w BEMES Velocity from PLC_018  D1000 WORD 10s
B
o ;8% - B
@ mE BEEESEE : PLC_018
.
& e FITE FTEEK HBES
" SEEE 01201 5_communication_status
e 01202 a_device_status HERTRE
N ZEIF
01203 a_crest_factor_acceleration_imp Default configuration
E = 01204 ¢_crest_factor_acceleration_imp Default configuration
n1206 a isni1N816 1 10h7 1khz velncite Nefault confinuration
S R —

: SmartCheck 38
: admin

=
o)
7

N

[
hi (1

[

HE v

B

[ j EF e - 2019-12-17 12:23:04

FEELA : admin

¢

|4

: 2019-12-17 10:27:18

B ET|
0.0

it

=

Crest

1301

(*SOFTCONTROL:

VERSION:7.04.01%)

TYPE

SmartCheck 10_179 8§ 82 T:

STRUCT

config_version: INT:=1;

s_kommunikatonsstatus: INT=0;

a_geratestatus: INT:=0;

a_basiskonfiguration: INT:=0;

END_STRUCT:

END_TYPE

VAR_GLOBAL

SmartCheck 10_179_8_82 AT
@"%MW0.1000,%MW0.1001.%MW0.1002.%MW0.1003":
SmartCheck_10_179 8 82 T;
END_VAR

PROGRAM POU
¢*)

L)
VAR_EXTERNAL

1 SmartCheck_10_179_8_82: SmartCheck_10_179_8 82 T:

Crest] &~

MOVP( SM402, 1, SmarCheck_10_179_8 82.config_version );

END_BODY

5| END_PROGRAM

CONFIGITRATION srConfionration

4. @it CTRL+A EH#HEOMAR, @id CTRL+C FH EHEF iR @1 CTRL+V FEFME— 1G24 (Bl

#N Microsoft Editor)

5. ERANXERSN .ASC HIEE R TMEFUE (a0 : SmartCheck 4. ProlLink01.asc),

o WNRFAME Mozilla Firefox ¥ %525, NAIEEEL BFENFXHERE N ASCI X,

g

$I% 6:1EZ A GX Works2 & B & X4

o THHAEXMHHIELY LASC, XFEFRER GX Works2 #ifi5:ER,

£S5 A Schaeffler SmartCheck 4. ProLink ER& X 2 BIiH £ A BB IE,

g

Global_Vars ,

#.i; Project > Open Other Data > Read ASC Format File,
Sk EAIEM ASCI X (.ASC) F i HEE.
A Schaeffler SmartCheck E4. Prolink EZiESC#, F+ B EN R iEA{E N#F# Global Label, &34
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[EE MELSOFT Series GX WorksZ ...bi

iSonst DemosteverungFAGYFAG'\FAG_DEMO_Rack - [Global Label Setting Global_¥ars ]

i Project Edit  FindiReplace  Compile  Yiew Online  Debug  Diagnostics  Tool  Window  Help =0
WL AL L LY BRI TN Iy
EEEFEE T I I s Ry
i Navigation ax £ Local Label Setting POU_A1 [PRG] rﬁpou_m [PRE] Frogram [Structured./ &Lﬁlohal Label Setting Global... ] 40 -
M ] Class Label Mame Diata Type Constant Device ﬂ
; 1 |wAR_GLOBAL = |SmartCheck_172_26 205_46 |SmanCheck_172_25_205_46 T D etail 5 etting Detail 5
[P 2y (2 Gs 2| M z =
{3 Parameter 3 -
[} Inteligent Function Madule 4 -
Jl_} Global Device Camment 5 =
= Global Label g -
% Globalt 7 -
% Global_Vars 3 =
[#-fizg Program Setting q =
B4 ol 10 -
'_j Program 1 =
=4 POU_D1 12 -
4§ Program 13 -
: @ Local Label 14 =
{8 PoU 15 -
j FE/FLN 15 -
B Struckured Data Types 17 -
Local Device Comment 18 -
[+ Device Memary 19 -
----- Device Initial Yalue 20 =
A hd
......... o -
Jﬁ Project 23 hd
24 hd -
L_..I User Library o | >|
= Systemn Label Operation *Tq reflect the cha
Connection Destination f
!i Change O Register Release system label databa
OEME Motification el | <]:' Dievice Mame Relation please save the pro
»
=l | i
Structured QOEUDEH Host Station Line 1 Cal. & L

£+ Device f i Detail Setting I, 135 RIFHEH SHEXFES:

SmartCheck_172_28_205_46
{Smartcheck_172_28_205_46_T)

Label Hame Data Type Device Address 1=
conlig_wersion W ord[Signed] R Zhw2.98
device_status Word[Signed] R100 bW 2100
standardmeszaufgabe Word[Signed] R101 kw2101
io] 0816_1_10hz_Tkhz_gf'\Word[Signed] R102 EMwiz 102
communication_status Word[Signed] R399 Zhw2.99

]

Cancel |

4

[ o ]

¥ aAutomatic Fillng V¥ Use Bit Designation

SR 7ILHRBEFHEMERFRS
1. @ EFR AP Compile > Rebuild ANLLEL5if2F .
2. FRUHERFFFEACMERHRS

8.7.2.5.2 = Z 1% GX IEC Developer

SR 1 ABRRHRGPBEERE
B5%ikE S Schaeffler SmartCheck 4. ProLink & T RIEFTEMMESH:

1. #TF GX IEC Developerii ik,

2. H$il; Project > Open,

3. $TFN4F Schaeffler SmartCheck E4. ProLink BLE XS AHE BRI,
4. ESMBEO S NG Parameter > PLC Parameter,

122



Q parameter setting

FLC narne |PLE zyzteni |PLE file |F'LI: RAS |Device |F'rc:gram |Boot file |SFE |I£D azzignment  Builtin Ethernet part

—IP address

|rpit Fiarmat I DEC j'

IP addrezs |

172 2g]

205]

127]

Subnet mask pattem [

Default router IP address |

5. TEiTi-k Built-in Ethernet port 1 #.i; Open settings,

FTP zettings

I Open settings I

Time seftings

Setifitis needed] Default / Changed |

IP Address/Port No. Input Format  |DEC e
Protocol Open System TCP Connection H‘::rfﬁ:on ?:it; darzg: D;zf?;g?n
1 |UDP ¥ |MELSOFT Connection hd hd
2 |TCP ¥ |MELSOFT Connection hd hd
3 |TCP ¥ |MELSOFT Connection - -
4 |TCP ¥ |MELSOFT Connection - -
5 |TCP ¥ |MELSOFT Connection v v
6 |TCP ¥ |MELSOFT Connection i i
7 |TCP ¥ |MELSOFT Connection b b
a |TCP ¥ |MELSOFT Connection hd hd
g |TCP ¥ |MELSOFT Connection hd hd
10 (TCP ¥ |MELSOFT Connection - -
11 [TCP ¥ |MELSOFT Connection - -
12 [TCP ¥ |MELSOFT Connection - -
13 |TCP ¥ |MELSOFT Connection i i
14 |TCP ¥ |MELSOFT Connection i i
15 (TCP LIMFI SOFT Connection b -
I 16 |TCP v [MCProtocol - - 1280(]
(*) IP Address and Port Mo, will be displayed by the selected format.
Flease enter the value according to the selected number,
End I Cancel

6. PATTIINE:

Protocol TCP
Open System MC Protocol
Host Station Port +i3:#: 1280

No.
7. =i End BIAKE,

[
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Q) parameter setting

FLC name IF'LC zpghem IF'LC file |F'LE RAS IDevice IProgram |Eoot file ISFC II.:’D azzignment  Built-in Ethernet port

—IP address

Open zettings |

|nput farmat I DEC ﬂ
FTF zettings

IP address [ 172 28] 2o8[ 122

Time settings |
Subret mazk patterm [ [ [ [ |

Default router IP address | | | |

Setif it is needed| Default / Changed |

r— Communication data code—

' Binary code

™ ASCI code

¥ Enable anline change [FTP, MC protacal)

[" Disable direct connection to MELSOFT

[ Do nat respond to search for CPU [Buill-in Ethernet port] on network

.&cknowledgeWassignmentl Fultiple CPL settingsl Default | Check | End | Cancel |

8. 7 Communication Data Code i F %&£t Binary Code,
9. ;% Enable online change (FTP, MC Protocol), MR #1244 %R 4 B A Schaeffler SmartCheck 4. ProLink
iR,

10. . End,
11. [GEFEEZE Task /1,

ESmartCh eck_IEC - GX IEC Developer - [MAIN_LD (Prio = 31, Event = TRUE}]

- 0] x|
_15] x|
C&HEE|m & oF | |
POU name Comment |
Project [c:\FAG\SmartCheck _IEC] 0[POU_01
| vibrary_Pool
Parameter
-G PLC
- Netwark
-l Module Configuration
EILG Task_Pool
D [MAIN_LD {Prio = 31, Event = TRUE)|
=34 DUT_Pool
- BH smart_Check_172_28_205_46_T
----- L@ Global_vars
=-ag Pou_pool

B3 POU_01 [PRG]

IE Project Object Edit Tools Onlne Debug View Extras Window Help

sE SR ¢ 2R (B 8|S e g

SmartCheck IEC =)=

@ Project Iug Calltreel T2 Used byl |L|j

Ready

| €Ty 17:37 [TASKMAIN_LD: Event TRUE, In [Q20UDEH 4

12, @i EFE ik Compile > Rebuild ANLUEIC4if2F .
13. R LM EEHRS,
7€ Schaeffler SmartWeb ## b4k 4L ER B = HI R 5,
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%1% 2: 7 Schaeffler SmartWeb % {4 b iF NS R 4%
EREEBEET TR GRNITHA S, ZA S5 S BRI S Bk OB EEEE:
o HE—NMTRIDEFEANEVBEEREMIZEN RS,

o EE_ANTRIPREEFRAMUTIESR:

FEinEFEE

Schaeffler SmartWeb

&3

1 EREFEERD

2: EL® Mitsubishi Controller

[SLMP)

Pl
fehmiR =

#5%: BLH Mitsubishi Controller {SLMP)

HI:| PLC_018

1P #dk 2 | 17228 205122

W|O:| 1280
EEEH
Wil :| TCP -
HHWRIN ;| Binary -

E---‘::. -

it

iz EEC ¥ Mitsubishi Confroller &7

e o o
NEABETHEOLUD

=8

PLC_018

172.28.205.122

T3t 1280 (F8&F+ 71kl 0500)
TCP

b |

A RN/ S B R I R Gi [odE 17 s R B X F AR MNIE R R AN E S E R,

Cl

FEMERIRVE, TR dnE RN R mREIMRERSEHN, NEIREHBAES,

S 1% 3: 7 SmartWeb K {4 dh i N &l & 4t B %0 A i
= BEEEMNH AL : PLC_018 Wi T Ad i #A # HMA Al EOhIHMTUTRE:

o

[
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LA

Schaeffler SmartWeb

£/ | FSPLC_0M18E9EE

TR | D1000 (7]
FEEER: | WORD - @
BEE: | S=sa v Bir: rPMm v @
ERAHE: | 13 - @
E5H: RPM
B [RPM] : 200=2
163,837 .
By
16.38 100E3
B [RPM] 2 .
0.0 SLEs
2E3 4E3 6E3 EE3 10EZ
BT BAAE
o 0.0 10,000
2% #5% PLC_018
MIREFR D1000
FHEHExE WORD
iR 7% :c4 AR [ 3R
L::R (72 RPM
FHEE 1% Max s fEiEgy 10000,
ESE B3 Min S AE 0 F4H0 Max Hi A # {5 3000,

1RE]1E RN [ 4% 58 120 1 T 45 B A A\ B (1082 1 R B % Fanfal R iR S RS AR E 2 A,
o HERE7E Schaeffler SmartWeb #4465 T4 Ak, a7 S i B R [\ il 275 B

=1 Schaeffler SmartCheck 4. ProLink % % B HIE.,
o LA B AT R P ER 4 A 15— REFE I 84T 25 ch AT R

T 4: 7 SmartWeb {4 th 6l 2 #2 %R 5t 89 % H B
7 GBS EE R M H I PLC_018 Wi T mdi G 3# B HRSHE - NS RPETUTRE:
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AR

Schaeffler SmartWeb

&R S TR IS ER

1: REFTEMEFRE

P ’Wgﬁif* : RETE o
E?:I;;*: . e
FHEEER e
WA EE RERS H RERE
o BERE A
i — i BEREEE v
— % Base measurement job v
QAT LEEE LY
@ FUand Tk (EEY) -TI—LBETy 7
v
@ 120108161 (2Hz - IkHz,‘u-;EiE . v
Q@ o7 b —E—F I (BEE. ) v v "
THEEE ki Exy
RTFFR D1200
BEE TR LR TR R R BB M B R,
AT AR E Bt B AR BAE S5 15 (R BN E RS S50 ISO 10816-1 FHEHIE PR ERAE

BUE 0TI R AR A R BY/ME

ERSHE SR AELEMNMER B RN FRE . EEERMN/ 558 R 5 R 5% 3 NS b B X F anfa
QIR EFEF RS M IRMEENEZER.

H 18 5. G B AR R 5 H i B E X4 77 SmartWeb % th
1. 7 BEEEER St S B L 2 R 4 (B0 PLC_018).

2. md ¥ TREATTHREAEHRS M SR E Y,
3. STHEEXH:
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Schaeffler SmartWeb

Tt w FEv JEEE VY EA VY
2§ BiEEE
£} PLC_018
172.28.205.122
wmOo . 1280 R
Bl TCP
SR, Binary
= - R
ope OPC UA server s wR -
oh PLC_018
BEFA—u BiEEEMSA : PLC_018
+ [ &%
@ #=% B WHATE iR BRAR
w BEMES Velocity from PLC_018  D1000 WORD 10s
B
o ;8% - B
@ mE BEEESEE : PLC_018
.
& e FITE FTEEK HBES
" SEEE 01201 5_communication_status
e 01202 a_device_status HERTRE
N ZEIF
01203 a_crest_factor_acceleration_imp Default configuration
E = 01204 ¢_crest_factor_acceleration_imp Default configuration
n1206 a isni1N816 1 10h7 1khz velncite Nefault confinuration
S R —

4. @it CTRL+A EH#HEOMAR, @id CTRL+C FH EHEF iR @1 CTRL+V FEFME— 1G24 (Bl

#N Microsoft Editor)

: SmartCheck 38
: admin

=
o)
7

N

[
hi (1

[ j TEE 20191217 12:23:04
: 2019-12-17 10:27:19

FEELA : admin

¢

|4

B ET|
0.0

it

=

Crest

1301

SmartCheck_10_179 8 82 T;

(*SOFTCONTROL:
VERSION:7.04.01%)

TYPE

SmartCheck 10_179 8§ 82 T:
STRUCT

config_version: INT:=1;
s_kommunikatonsstatus: INT=0;
a_geratestatus: INT:=0;
a_basiskonfiguration: INT:=0;
END_STRUCT:

END_TYPE

VAR_GLOBAL

SmartCheck 10_179_8_82 AT
@"%MW0.1000,%MW0.1001.%MW0.1002.%MW0.1003":

END_VAR

PROGRAM POU
¢*)

L)
VAR_EXTERNAL

1 SmartCheck_10_179_8_82: SmartCheck_10_179_8 82 T:

Crest] &~

MOVP( SM402, 1, SmarCheck_10_179_8 82.config_version );

END_BODY

5| END_PROGRAM

CONFIGITRATION srConfionration

5. ERANXERSN .ASC HIEE R TMEFUE (a0 : SmartCheck 4. ProlLink01.asc),

o WNRFAME Mozilla Firefox ¥ %525, NAIEEEL BFENFXHERE N ASCI X,

g

$I% 6:1EZ A GX Works2 & B & X4

o THHAEXMHHIELY LASC, XFEFRER GX Works2 #ifi5:ER,

£S5 A Schaeffler SmartCheck 4. ProLink ER& X 2 BIiH £ A BB IE,

g

1. *idi Project > Open Other Data > Read ASC Format File,

Global_Vars ,

F LT GIEE ASCII 30 (LASC) F I LHTE.
A Schaeffler SmartCheck E4. Prolink EZiESC#, F+ B EN R iEA{E N#F# Global Label, &34
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Iﬁ Project Object Edit Tools Online Debug View Extras Window Help =] =l
@SR @R[> s = E | E 1L

SmartCheck IECZJJ Class Identifier MIT-Addr. IEC-Addr. Type =
Project [c:\FAG \SmartCheck_IEC] 4+ 0VAR_GLOBAL ~[Smart_Check_172_28_205_46 |lconfig_version: R98 |jconfig_version: %MW2 |Smart_Check_172_26_205|

E-'filfl Library_Pool
Bl - Parameter

11"" Network
5 ----- Elll Module Configuration
-4y Task_pool
...y MAIN_LD (Prio = 31, Event = TRUE)
E-§§ DUT_Pool
-89 smart_Check_172_28_205_46_T
-Ig Global_Vars
B ﬂ:ts POU_Pool
-8 POU_D1 [PRE]

@ Project |°|*_—‘> Caltree | 92 Used byl | | Ll—

[T 17:34 [GVL: 1 Dedarations |qzouDEn G

7EF Device F1#.i; Detail Setting I, 15 Z RIFMHE(HEHXEEFS
x

Smart_Check_172_28 205_45 [Smart_Check_172_28 205 45 T)

Name Type | M1 T -l | IEC-Addr. -]
1 |config_version WORD R9e bW 2 98
2 |device_status WORD R100 Zhiw/2100
3 |standardmeszaufgabe WORD R101 M2 101
4 |izo10816_1_10hz_1khz_g ‘wORD R102 w2102
5 |comunication_status WORD R399 Zhiw/299

-
4| | »
v Autamatic filing [V Al Types Export Irnpart | Ok I Cancel |

SR 7 ILEEFFEAERNRS
1. BT EFE Ak Compile > Rebuild AILUEICHIERE
2. #UERFEEAHEEHRS,

8.7.3 F OPCUA R % %% B 38 15 & &

OPC UA 2— ML & M BISHEUIR R ik, £ °°° B 15818 (OPC UA fR%-38) [OREH, RaiE
Schaeffler SmartCheck E4. ProLink ¥4 1E4 OPC UA BR%5 28, 2AJS, RTLAME iSRSt ER % 3 4 ROSFAE(E . tE4Y, 4
TR EAEH RGN RS HEN OPC UA BR% 235895 A H 2 S E| SmartCheck E4. ProLink W& H, NTH E*IJFEIH:,E‘
T, EEHITTHILE:

o BWAZIE SR OPC UA BR% 254 ol S Bt 1o, It AT LA HA 7 BR 55 25 8 O 0 T B2 A0 5361 3042

o MREAEIT OPC UA RS BB MEAMIZHI RS AR, EBFUNILRIN— 82 OPC UA AR5 28 0k At [132), 41

X]‘iXﬁB’JinJJ\iﬁ“ﬁZwﬁﬁﬁm/M"“ﬂﬂJ%éﬁE’J#ﬁ%‘%b&ﬂlﬁl#ﬁE’JﬁiﬂuﬁﬂﬁdﬁﬂE]Zluﬂ It 5V 02T TE B 7 2 SR N 45 IO
,.,\ﬁ?E’J1=?$1_L$D,.,\$%‘?E’J1§%1ﬁfﬁIo

o W}y OPC UA FREBFIMEBE S MALE, AT SmartWeb Fffhoh i X i A lh, 587 AKECE [ 5 X t3f o
#t 19— R 25 EE S e, I "ﬁ—@'ﬁﬂuﬂ S 28 0V X ARG B A SR AT S A

e {FFA— OPCUA E/ ' iIn AT A @i OPC UA RS 25 vl FMPLE 304, AT ELLLA OPC UA fR%5 28 Tk mlig =AY
1E,
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8.7.3.1 AT OPC UA fiE %5 25 198 15 B E X 18

TEREBRERE A E BN S Y FI154 Schaeffler SmartCheck ZE 4. ProLink 14 35N OPC UA BR%58, 75
AR TERFAIERE|IRTF OPC UA IR FJ/FHIERTEE, MREHRMT HAMAL, CaEX FEMAMRMIER:

E# : SmariCheck 36 ®
55 admin

ZEE

Schaeffler SmartWeb

=it w
[ BiEEE =]
E¥al: 2019-12-18 20:15:42

T &3 : 2019-12-18 20:15:42
EZLA : admin

orc OPC LA server

S R Ll &
M PLC 018
EETA—u BIEFEBAHE A : OPC UA server
+ () &&
@ == =k BAMET BRES L2 BAFFE BASTE R
wl ERSEE | Speedinput -10.0 100 [kHz] -10.0 10.0 1.0
o EEEE
() == 7 = -
e

mili OPC UA fR%5 2%, BIRIFERR R TAER i)l LIT{E B FNThAE:
TELE AT EI R F OPC UA RRS53RA0E A BFMIRE:
o AERFFELMLCHBIFTEAMIRS /O,
o MMREFE OPC UA REBBIIE, TELALEATHEIRAF 2 MELHEXER,

o SiESIN T, ENEIAM—4 OPC UA PR35, IRET7E N0/ 448 OPC UA AR 2528 [+aNusi T #5348 2 vE4n it
B,

o mkigE S ENEIZ%EE OPC UA FRZSS, #XET7E SR A0/ 4045 OPC UA AR %38 [adVii T #k BIAE 3 40 A,
o EATNNER OPC UA RS 25E1EEE, Nk aT S B — KRR STHEHTHIL

. mEEAaEEpTTRRE—wR,
BEFBENRA
X B ERE N OPC UA BRE FROIZBMM AR — R, ISE LA A 3RB LA TE RFNE D
o RIBFAESHNMAKMER, BRTAMZS, CESFMBELBIBNMESHEEBEER/MIZEESR
XE), BEB T FEREEH FERER/MEIEFTERERKE) LR LB B i,
o MR £ ENEI4 A LE, (REIZESRIN/ S5 OPC UA AR 238 0% A i [R5l T4k BIAE 3 a4 183,

o BTN T, ENEIAINE S AL, RN/ % OPC UA BR %5 35 80%) A i [ 200 T+ EI48 3 1403
Eﬂo

o EETLUMBRFT LBV A LA R BR —, REREHEHITHIL,



[

J EREMBRELESE WEES o) hRIH AL, EXFFAIER THIBR — RAWER, MR
!; e S ERA AS, WA SEMIBRIETE R A ERIIE4E 5.

8.7.3.2 H hn/4% & OPC UA iR % 35
A¥%F Schaeffler SmartCheck &4, ProLink ¥ #% F{4E OPC UA fR%-2%, iR nAB N @S @58

[

£l OPC UA [R&B[HEEEE

1. AEEBEEFTAGEMN T sTFES, ZRASE5ISES RIS BRI ERERE,
2. BE—NHBRhEFBERESE OPC UA IR% 5.

3. Rk AE NS T, FE AR IIREAE X OPC UA R4S S[HIFTE 1M BR

RREEEE

Schaeffler SmartWeb

#3 3. ii® OPC UA [RE5

1 R EEET

2 B OPC UA 52 FREEERO: | 4340 (7]

BEEAE
Wik
THEEE B R et
BB LT IR
R%2im0O TELE AN A SmartCheck 4. ProLink % AR 288 TCP 50,
) OPC UA #rAETERR S 278m O 8UE N 4840, (NEERE R LRER
g‘ BOIE R T F ol B St 3

BURRIAE IR GRS A MR ISR, EECEIZET, IRiZETEE, GRRERS
LT/, @A SmartCheck 4. ProLink ¥4 I s 4 FREL I L 4T OPC
UA R1E, Bt B /R %5 A0 1% 15 ol 2 g A BB R I BB R |l AL,

4, mdiSERL, &7F OPC UA BR4S3H0EIEEE .,
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%% OPC UA R %535 80:E 15 858
1. AEMERFEM—ERPEH OPCUA IR,

2. ERRTARBIEEENTAGHES  HERTHRNS BRIREFBOEL.
3. mili SERMAER,

8.7.3.3 F /4w % OPC UA R 55 38 B0 57 A i
Schaeffler SmartCheck &4, ProLink ##%@iT OPC UA fR% #2804 AImk B X TEMIEHI RGP ESHER,
£ OPC UA AR 35 #9% A i
1. EENBEFEHN—%NRDEHS OPC UA AR 35,
2. EBEEBEMBMALL:OPC UA IRESBHIFALFM T,
3. ERNMBMAREODRIBFAEMNESR:
EEMA,

Schaeffler SmartWeb

H¥:| Speedinput

FEESE: | FLOAT - @
REE: SmEE v | Bfir:| kHz - @
ARARB:| 15 - @
=5H: kHz
WK [kHz] : i
10.0 1c
. 5
1.0 0
= [kHz] : -5
-10.0 -10
-15
1 5 5 1
BT BASE:
(7] 100 10.0
A LU R
& AIEIX BIEE AEE SmartWeb it &R A w2 #h o
oy E i) TE LA A BUR AL AR = Z UL E R R FRREER,
BRIZFLUTER:
FLOAT 32 {u
B f BFD TELEIETE, BUE LT 4 BB EF P MIZEH RGP T
LR )
153K 5] F@ TELLFATE, LUBSFRIAIEEMIZSI R G R iE R EE,

MER B S TZBIME — FIANEE, WIS — T KEITER R, B AT R
REEMERRSALA,

HHFE — BT HEHRLE LB EFTRFER. RARTUFIERR/NFFEN/
BERAEFFE, SFFEEHE LB REER N, XBELE,
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E5E PR LB m] IARB TE SRS A0S SEAEM— 1 SEH R B fA— 1 &/IMHE Min,
REMA— P RAM Max, SEFES MU AESE AR HEHIESHR
. ABFEFNEBEHBRLE, hRHBEEHEN N AERNL.
4. Ry OKENAIRTFHT A5 Al
e ® 4 A v ow ) -

TN AP ESESERE DY 0 E 3,000 RPM, FfFaR a9 BSERERZ 0 = 10,000, AL ERESM B A
i, ENGAITIOTRE :

Firarad FLOAT

=R <3 AR [ iR
<R (72 RPM
RINEFHFE 0
RKREHFE 10,000

= XESE 3000 (RPM)
®/MEBE 0 (RPM)

SRAmRBMN— T RFRE

AT LA A S AN 4B 0 B 7E G — AT 55 [ oo W oh ELHEAT U M RO IR R B BT LUARIBTE T8RO B — 04 £ I E RO P28
B, BUAMAREHETEHZEE.

B - {58 PR A S U T ARG FE AT IR B 5 o I HCFE R IR 3/ 5 5 IRRI LU L6 — DN IRR B
1. 1A %0 78 AT 0 ) 76
2, N FE R ImAO R, % 0.2 (1/5

1. EREDEBERENRAL: [2H]0 T ERmENHAL,
2. il P R R RSN AT,
3. A T A FENERRRNED:

NN
BNEE
21G830 - Retational speed before gear
&R
Speed before gear
AR
0.2
Eafiy :
RPM v
®E g
BB LT EIC:
A ¥R EZEAMIM T HAEMRBEEERMA LR, RLEEEFE—1RAEERTBES FRAHA
I % o
THHRE FERXEHMANERUYEHAES,
LX) EXBA L ERLRIFIESHIE AL, X B BOA L PR A i ED & 8 AL,

4. RIEFRENAREFEHERAR. FHGRREHNERRREIIRZH,

TR EEATI R, RIEFEIX B FARN FIHE T R M BRSE S H A R
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BSEEE ), : 216830
BAES B BihEEE BAESEE

B imsEE  SEX.. ERAR B2IMES
4 Rotational speed bef... RO INT 108 -32.768 32,767 [Hz] -32,768 32,767
IR E
Speed before gear 0.2x RPM
s =5
HiEz
W ST
P i3 + HRi0

WA LAZE RN E LI B R 4B AR AP ME AT LI HFAF I E T ENES.

MEMBRE-DNEFEFERANGRRY, REAUSAEET—FK
th & B I BRAE N AT B 4E 55

i

Ym%E OPC UA PR %525 89%0 A 3

1. TEENEFEH— iRkt OPC UA FRSE,

2. EERETEEEENE AR : OPC UA BRS L1 T 47 FF EH0i A LS,
3. AEgiE / HEEGEBHAREODIERFENES,

4. mHHEEEERIAER,

8.7.4 PROFINET & & {5 '@ &
IR B ProLink CPU H1$HA T — PROFINET #b:, NESERERBHERANEEEE, BEZEEEEMHITTH

S i R BRI R 2 [ 108, AT I B 3R 1 BRI (AN ProLink & BIRRA TR EARZS . th AT LUE I 18 3 SR 172 FF i M %
HIRGKZE Prolink B4, HIELAAUF ProLink ¥ #BITRFHIECIE )y SmartWeb ## g Adi. [BUkst, #2HIR5%

R AR SRR iah A AT AR I R B IR ERIR

ME#RRA 2.0 &2 B3] PROFINET #85, H#FH LR VEBIEEE, MBRLTR, @i 78
> BHE G W aEEHIENE .

o

8.7.4.1 PROFINET i i& 18 18 & X 18
B R EE XA R FFRIZE M & P Ek PROFINET &R EESEE, ZE15:8E R ProLink %4 EiR7FIM, R
Mirh R TAERX A AT#EIX T PROFINET BEEEMEARTFIFURX TR ARMER:
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mi PROFINET @15:&:&, BNnlE R T/ER Ay i LU TS BF0DhEE:

Schaeffler SmartWeb

TEw FEv NRHE v E5 v

[

=%
- B &
M ASRE
+ © plizs
+ - pepE
& pRmEE
+ 7 AREE
- < EEEE
aw PROFINET
+ @iz
© #Bx
wl HESES

[OF=2
=@

EEEE

£ % : PROFINET

MAC © 00:30:11:51:C&:39
B 203

EEEENSA : PROFINET

-1 3
B Speed PH

7 EE

®E: T

i A E T

283859 1Pv4 B4k © 0000

Bl

BIrER RAER
0.0 100.0

B

|4

ZiE#E : Schaeffler ProLink

28R K - admin

B v

=]

SE# ¢ 2022-10-20 16:16:06
Eélm= : 2022-10-20 16:16:06

EBLA - system

BAHEE iAW

100.0

1.0

X BAHLE|X T ATt PROFINET &1 RERIEARIE B MIIEE:

[

o BRTATF. MAC it FNEI#HhRA 244, BRI LURE] ProLink B4 FNIEHI R S h M m 4 FR LR WK BLE AT

o REEMEBEBENBATRE:

- BiERE:

PROFINET B&{SEBEL/EIEE,

- BEEH:

PROFINET BISBEEEiTHiE 7 e,

» REI:

ProLink % #% &5 /SF PROFINET #&k,

= ZEE

PROFINET #&EHt &k S H| RS HHIE

» MEHR:

EHRGEEH IR,

o B ¥ FHASEHRSHREAN ZIP X, EhaSLTHE:
= Info.txt:

ProLinki% # #) PROFINET #££i4E N DAP (X &EAR) T/E, MEEME, EAE— 1MW ENFE. &
info.txt 34 F A £k B W20 B L A8 B AN{aT 3E 1T 4w F2 LA K. ProLink % 45 RN 2 40 2 18] 3 $ R LE B 34 F03E
AR EIRRTEMIE R,

» {4 gsd:

XA R E 54k R gsd.xml 3Xi, E AR T Prolink $#0,

= Xk s7:
TE %3 e ch A R B IR E A FNFE R BUE B R B

o HiliiE /| EEIZi% PROFINET SES5E:E, AE AL AR ELH%E PROFINET B304,
* o ENEARINE @ EEE ),

o i

o AELEAAEmEITRRE—wEEMN,

BEEERMEA
X B EEE v PROFINET @5 @& 02 MM AR — W R B LA RIIRIF LTS B FIEIT:
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o RBAEMNMARMIER, BRTAMZN, CAEFINFEEBIRMESHEE ESR/MEEES R
KE), BEPNFEREEH (FHESER/NMEEFERERKE) UK EFRHHERH,

o mimiE 4 BNRIGIHEI AL, UREI7E RN/ 4058 PROFINET 38158 8 B A 1 [ 00l F # BIA8 5 v an

18
o BTN T, ENEIAINE B M AL, (REIERIN/ %% PROFINET 58 {5 58 & A% A i [0V T B4 3%
gﬂiﬁéaﬂo

o & TTLUMBRATIE AU AT, UL AT R MIBR T, RE REHEE TR,

3 o MEFHNEES, WEEL info.txt X, RABELFEH TR ZIP SRR RS0
2 #7213
o TILIMIEHIR G EHES) ProLink ¥4, IEsh, & ProLink &4 % MREFHEN, ZEHRES
B 3hiH 3% & FF T R,

8.7.4.2 1IN0 /%% % PROFINET i {5 & & B9 % A i
AT L@ PROFINET @15 188 A% A S i 52 B 304 MR HI R SiAL 50 = ProLink %45,

A PROFINET & 5@ E B — 1Al

1. EEMBEFEM—FFiEF PROFINET &EE&EE,
2. EEEBEEMH AL PROFINET i F &AM + .
3. EFMHAREDOPRERENESR:

vk N
BE:
Speed
HFEEd:
FLOAT @
Bi0E: o
rpep— v e @
WREM:
1% -~ @
ERE: e
Bk [Ha] ~
100
e !
1 50.0
B [Ha] © =
0
BEEE Lexed i
2] 0 100
B/E mE
BB LTI
2% AITEX B8 E AR SmartWeb B4 A B =% A i O 4 F o
e R i) RH FLOAT HFEAXETA,
B f BF FULIERE, B U 2 MEBEF R MEFI RS R IEITH IR,
;<R3
18 K 5] @ TELLFATE, LUBFE R MIERI RS P15 R EUE
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MRZ BRI EZEBHEE — PIUNERE, WG — D KA9TEREE. B aTRER%

wE.

HHEE — B THEFHRLE N8z XBERFER. RETUFIERR/DFFEN/
BERREFFE LEFFCEHE B3R ERER/NY, XBRELE,

E5E PR LB m] BB TE SRS AE SEAEM— 1 SEH R & fA— 1 &/IME Min,

REMA— P RAM Max, SEFESBUNAESE AR HEHIESHR
. ABEFNEBEHEBRLE, hRHBEEEHEN N AERNE.

4. mili OKENRIMRTF T894 Al

S AR — AR
T LA i A B S N5 0 B 72 6 — A 55 o0 W 0 ELIEAT U RO IR R HH o BT LUARIBTE T8RO B — 04 VI E RO P 28
B, B4R AREHETEHEMZEE.,

B - {5 AR A S U R LA FE AT IR B o o N FE R IR B3/ 5 % BRI LU LA — DN IRR B
1. 1A %0 78 A1 B B 7% 5
2, KR FERmAIFE, R$0.2 (1/5

1. ARBRTBEBEMNAAL: [EHIT T ARRENH AL,
2. il P A RSB BIRATIE,
3. ad T TR AENSERARKNED:

NS
\NEE :
21G5830 - Retational speed before gear
=12
Speed before gear
SRR
0.2
Bafiy :
RPM -
E e
mBE LTI
& ¥ EZAEMI T HAEMRBEEEMALR, RLEEEFE—1REERTBESTRIHA
I % Fo
THHRE FRAXEMANERUYERAES,
AL EXBA L ERLRIFESHTTE AL, X B BOA L P 0 A b AR & B AL

4. RBRENAREFENERAS, FHUSRRRHINEFRREIIRZH,
R AT X B F, RETEIX B F48 N H e 5 R M BREUE i i 40 R 3L

BSEEE ) 216830

B MasTE  SuR.. ERaR BIMES BAES B BIETFE BAEFE
4 Rotafional speed bef .. RO INT 10s -32,768 32767 [Hz] -32,768 32,767
HIIEERE
Speed before gear 0.2x RPM
s =B
HiEz
W mHET
7S =5 123 +

AT LAE R E L BR[O R h, MR LN & FRATF I E 2SR EMES.
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MEMBRE-DNEEFZERNGRRY, RAUSAGERT-REEER. MEMBRYGRRE,
lli th & B 0 BRAE N AT E4E 55

Y548 PROFINET & {S 1@ 8 B9 % A Ui

1. EENEFEH— iR hikt PROFINET BI5:EHE.,

2. ERBEDBEEBENS AL : PROFINET Il F L FFEMMAL.
3. Al 7 FAEREHABEODERFENES,

4. EEHEEERIAER,

8.7.5 Schaeffler Cloud & 15 i &

@it O EEiEE (Schaeffler Cloud) DX AT LA B SmartCheck B4, ProLink 4 ISR A ML, AR EIS

Schaeffler Cloud B33 i®id SmartCheck E 4. Prolink ¥ & 58U 14 i & =i,

EFEFERATHTEE FEUTSE:

o WIiIEEEHE Schaeffler ZHR% [ 161 (Cloud-Onboarding). X% B 26/ Schaeffler Cloud B1S:@&H AT FRH
AERE,

o MENBITALRIEBEREBEREEE (Schaeffer Cloud) # Proxy &Xi&.

% F Schaeffler Cloud IR {8 285 [ Schaeffler K%,

8.8 &%

AR AT T AT & W B [0 R G 8 W B (1), A ENEER, BRI7EiX B #&F SmartCheck Z4. ProLink #
%HIERE, BB AT LA T


https://www.schaeffler.de/content.schaeffler.de/de/news_medien/mediathek/publikationen/downloadcenter-global-pages/downloadcenter-language-list-publications.jsp?pubid=87649857&ppubid=87649858&tab=mediathek-pub&subfilter=app:dc

[

881 & KE
ER A BB THIE %F Schaeffler SmartCheck 4. ProLink %4 . % LA R 15 % b B9HR4EF0 LED RASLTRITE4HER

Schaeffler SmartWeb

S&# © SmariCheck 36 ® .
SEF 25 admin
Tt w #FE v QB ZF5 v HE v
[ SEUR =]
5 . SmartCheck 36
4:3d.50.00:01:4b

MAC $24F : £4-3d-80-00-01-4b

=z

FeAE LED R

PSR

FEXEBEAUREILTER:

WERE
HEXEFIHET SmartCheck B4 ProLink ¥ %k & F. FFIS 1 MAC Hhilk (RM&khit), snREIEE, &t
SEXBHKIEAH VA 1 6LE .
ALER AW, B A B SITHER MEE AT S8 £ HERMATENER,

R4 /LED B
Schaeffler SmartCheck % &41H 2 MREFI—NIRA LED $ERLT, £ Schaeffler ProLink # & £ RIAER[#:E 2
MRELIRE 3 1 LED 4T,

ERE [LED BT T W E A VFE X SR P TR L 42 4 . IXPBEENAI R IE B 4ME/E SmartCheck B4,
ProLink %%, B4 AT LAIFEIX BIIE SmartCheck %4 ERIIRZS LED $5R4TE#E ProLink &4 BIRE LED 5=
STRENERHERES, R LETUAUTRE:

SMRE AIAEX B NEHRE,

EFEIEIRKX ARk EHE IR ), LA E HMRERERBERE, ULEHE
SRR ERE W (AR

ERE A AR EFHEZISmartCheck B4 Prolink 4, LR & XM, RARE
wE,

B E SRS AIARFF SmartCheck &4, Prolink X% EHTE FHITIKE . B EFNES
E¥R LR,

FFE LED KEKT RN R T LT FBUEIR S

IMRERZIEI, WX EMRSEHUTER:

e ProLink &% :#E LED $ERATHIES XM,

o SmartCheck ## 4K LED $8RATRIIRES S X M, ERHE N HE 4L
INERAT 2R AL T BB IR
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2 & SmartCheck 4. ProLink AEEI 4 6. BEEFLELT ERIERK
P

BN o

FOABURRIBY, LBALEEMEE, X TFTRIREB— MR EHSEMITAER, RIS Schaeffler
SmartCheck 4. ProLink /" F#ft,

AHRIB LT Bk fTiREE/LED #EMER:
1. midigeE £

2. TEYwiETRYE/LED BB O E AT VFAORRLE:
HRER/LED S E

Schaeffler SmarfWeb

=
InEIR|K

fir

4
]

b

Y
I

4]

4§
U]
W

g%
EFEELRERS

| FFE LED T

e
hil}
a
1ii

o MREUHE—MREET, ST ESHENMRERT IZEMN, EEITMREIDERME §EHFRE,
o WMREEGHE FFE LED KRALT, IFRE SmartCheck E4. ProlLinki% £ £ &R EIRA,
3. ATHHAENTREEHMERANE,

M BB

AT H A2 DHCP, EHLA TR, IP Hhllk . WX FIM DM LaTRE R R, AHRB LT 5 BT % B
B

1. midigeE 4
2. EEEMEREEODEEHENHIE:

ARFEER

Schaeffler SmartWeb

DHCP @301 DHCP £SWMRE (U ESENSF=as)

it
i}
24

BB LTI

%% DHCP PR ZE AT LU TE TP sk, sl k48 A SmartCheck Z4. ProLink #
FZEIERIN TP Hodt,
NEBETRE DHCP, MG ZSBhthnJdHTRERE, Fl0 IP ih

bt FRHEN. MX =% DNS IR% 5.
WARRIN— A L F U RIS Bl 3 B IF SMTP BR% 3851 1% Proxy R
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S BIEENBMIFETIEE N IP thilt B9FHE, F7iEFA DNS AR%38 .
XFRER T @IS DNS AR 55 2 A2 4T 5 7€ BIAR 55 32 & 75

DHCP &/ imtE = FIR %%k SmartCheck 4. ProLink %% Bl B EI#E AN %% th3ER IP it

(MIRZ 22 % =ML FR) ik, Bt 4% B9 DNS AR 4555 (Revers DNS) S B2 EHL4 s

DHCP % imi&E sk FIRiZE T SmartCheck 4. ProLink %4 7 B Zh A9 2% ch 3K ER IP it
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